GRADUATE COUNCIL: NEW COURSE PROPOSAL

Originating Unit: School of Music

Type of action: |[] [ New course Full online course**

Semester and year course will take effect: Spring 2023

New course title: Mariachi Ensemble

Appropriate computer abbreviation (30 spaces or less): Mariachi Ensemble
Course instructional methodology: Performance

course component types: ugradcouncil.tcu.edu/forms/Course Component Types.pdf

New course number: NMUSI| 60250

Prerequisites for new course: include an attachment if additional space is needed

Graduate standing in the School of Music or permission of instructor. All students enrolled in a mariachi course must be able
to play an instrument; therefore, vocalists will be asked to learn a mariachi-based instrument if they do not know how to play
one already.

attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments

Click here to attach a file




TCU Mariachi Sangre Royal
MUSI 60250-079

Instructor Name: Imelda Martinez and Ramon Nifio
Semester and Year: Fall 2022

Number of Credits: 0.50

Class Location: MSC 124

Class Meeting Day(s) & Time(s): Tuesday, 6:00-7:30pm
Zoom Access Information: If we ever need to have a class meeting through zoom you will be
sent a link to your TCU email for log in access.

Office Location: MSC 214

Office Hours: By appointment only

Telephone: (575) 621-9600, (940) 231-0359

Email: Imelda.martinez@tcu.edu, ramon.nino@tcu.edu
Response Time: 24-48 hours

Final Exam Date & Other Important Dates

A cumulative, public performance at the end of the semester will take place in lieu of a final
examination. Students will be expected to demonstrate growth vocally and instrumentally from
their performance at the start of the semester.

Course Description

This course will introduce fundamental music techniques, music theory relevant to Mariachi,
and Mexican historical background necessary to read, understand and interpret Mariachi music
in a culturally authentic manner.

The course will promote ensemble technique as well as individual growth in Mariachi
performance skills. Students will reinforce their aural and reading skills as they will engage in
hands-on exercises that will develop and refine their creative and intellectual performance
ability and musical understanding of Mariachi. Students will be expected to participate in
select public performances representing TCU and the university community. This ensemble
is open to all TCU students but is designed for students with some formal music education.
Prerequisites for this ensemble include proficiency in a Mariachi instrument or permission
from the instructors.

Learning Outcomes

Students who successfully complete this course will:
1. demonstrate professionalism, dedication, and responsibility through punctuality
at ensemble rehearsals and performances
2. demonstrate individual accountability through individual practice
3. demonstrate skills in the preparation and performance of music from varying
Mariachi styles

4. demonstrate growth and/or excellence vocally and instrumentally through individual
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recordings and ensemble rehearsals and performances

Prerequisites

Music major/minor or permission of instructor. All students enrolled in a mariachi course must
be able to play an instrument; therefore, vocalists will be asked to learn a mariachi-based
instrument if they do not know how to play one already.

Required Texts / Materials

e 3 Ring Binder

e Pencils

e Pencil Pouch

e Instrument

o Personal Tuner

e Cleaning Cloth

e Appropriate Accessories for the instrument being used.

ATTIRE

Informal Uniform Options:

¢ White-collared button-down shirt with long sleeves. Solid black shoes, black socks,
black dress pants or long black skirt (NO LEGGINGS).

e TCU polo shirt will be worn with jeans or dress pants, black socks and solid black shoes.

e Camisolas will be worn with black dress pants or traje pants, as directed by instructors.
A $50 fee is charged for a missing camisola.

As the semester progresses, the goal is to size everyone for a traditional traje. These trajes
are the property of TCU and are to be returned at the end of the semester. A $500 fine will
be added to your TCU bill for any missing uniform item.

Teaching Philosophy

We believe that Mariachi is a vital component of a cohesive music education. As such, the
instructors will discuss culture, proper diction, vowel connection, and instrumental technique.
Students are expected to come to class ready to be active participants in the learning process.

Instructional Methods

This course is an ensemble and, as such, students will be expected to come to rehearsal
prepared to perform their individual part and improve both individually and as part of the group.
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Course Policies and Requirements

Assignments

Students will submit bi-weekly recordings to demonstrate individual practice (LO2) and growth
vocally and instrumentally (LO4). Students will be graded on their participation in ensemble
rehearsals (LO1). The ensemble will host public performances throughout the semester to
demonstrate skills in performance (LO1, LO3).

Grading

Grading for this course will be based on Recording Submissions/Quizzes and
Attendance/Performances. The instructors reserve the right to raise any grade.

Final Grade Elements / Grade Breakdown:

Outcome(s) | Assignments, Exams/Quizzes, Presentations, etc. | Percentage | Points

1,2,3,4 Ensemble Performances and Recordings (15) 75 5

1,3,4 Attendance/Participation 25 25

Grading Scales

Grade | Score

A 90-100

B 80-89.99

C 70-79.99

F 0-69.99
Late Work

Late work will only be accepted ONLY if the student has communicated with the instructor
before the deadline has passed. A grace period will be given after instructor approval.

Grading Concerns

Grades will be updated regularly in D2L, if you have a grade concern email both instructors
before the next scheduled class.

Attendance

The University Attendance Policy states that “[rlegular and punctual class attendance is
essential for academic success and no assigned work is summarily excused because of
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absence regardless of the cause.” Expectations for this course is that you come to class all
the time and on time. One absence per semester will be considered FREE for each student.
Tardiness is unacceptable. Tardiness is defined as not being in your place with your
materials starting at 6pm for class time or the corresponding performance call-time.
Absences known in advance will be communicated to the instructor at the earliest possibility.
Absence will not be counted for classes when a student attends but is not able to vocalize or
play because of health or other related issues. Communication in advance about absences
for illness is still expected.

Absence(s) in the week leading to a performance may lead to the withholding of a student
from performance at the discretion of the director.

Each absence/tardy will lower the student's grade as follows:

Absences/Tardies Grade

0-1 No impact on grade
2 Final grade lowered one letter
3+ Final grade of F

Participation

Students are expected to come to class on time, ready to play their instrument or sing, remain
engaged throughout the rehearsal, and be receptive to feedback.

Class Norms & Netiquette

All members of the class are expected to follow rules of common courtesy in all email
messages, discussions, and chats. If | deem any of them to be inappropriate or offensive, | will
forward the message to the Chair of the department and appropriate action will be taken, not
excluding expulsion from the course. The same rules apply online as they do in person. Be
respectful of other students. Foul discourse will not be tolerated. Please take a moment and
read some basic information about netiquette (http://www.albion.com/netiquette/).

Participating in the virtual realm, including social media sites and shared-access sites
sometimes used for educational collaborations, should be done with honor and integrity. Please
review the relevant sections of the Student Handbook (https://deanofstudents.tcu.edu/student-
handbook/) for TCU’s network and computing policies and communication guidelines.

Technology Policies
Email

Only the official TCU student email address will be used for all course notification. It is your
responsibility to check your TCU email on a regular basis.

Course Materials

TCU students are prohibited from sharing any portion of course materials (including videos,
PowerPoint slides, assignments, or notes) with others, including on social media, without written
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permission by the course instructor. Accessing, copying, transporting (to another person or
location), modifying, or destroying programs, records, or data belonging to TCU or another user
without authorization, whether such data is in transit or storage, is prohibited. The full policy can
be found at: https://tcu.policytech.com/dotNet/documents/?docid=55&public=true.

Violating this policy is considered a violation of Section 3.2.8 of the Student Code of

Conduct found in the Student Handbook (https://deanofstudents.tcu.edu/student-handbook/),
and may also constitute Academic Misconduct or Disruptive Classroom Behavior. TCU
encourages student debate and discourse; accordingly, TCU generally interprets and applies its
policies, including the policies referenced above, consistent with the values of free expression
and First Amendment principles.

Academic Misconduct

Academic Misconduct (Section 3.4 of the Student Code of Conduct found in the Student
Handbook (https://deanofstudents.tcu.edu/student-handbook/)): Any act that violates the
academic integrity of the institution is considered academic misconduct. The definitions and
procedures used to resolve suspected acts of academic misconduct are available in the offices
of the Academic Deans and Dean of Students, and are also listed in detail in the Undergraduate
Catalog (http://tcu.smartcatalogig.com/current/Undergraduate-Catalog/Student-
Policies/Academic-Conduct-Policy-Details) and the Graduate Catalog
(http://tcu.smartcatalogig.com/en/current/Graduate-Catalog/Academic-Conduct).

Specific examples include, but are not limited to:

e Cheating: Copying from another student’s test paper, laboratory report, other report, or
computer files and listings; using, during any academic exercise, material and/or devices
not authorized by the person in charge of the test; collaborating with or seeking aid from
another student during a test or laboratory without permission; knowingly using, buying,
selling, stealing, transporting, or soliciting in its entirety or in part, the contents of a test
or other assignment unauthorized for release; substituting for another student or
permitting another student to substitute for oneself.

o Plagiarism: The appropriation, theft, purchase or obtaining by any means another’'s
work, and the unacknowledged submission or incorporation of that work as one’s own
offered for credit. Appropriation includes the quoting or paraphrasing of another's work
without giving proper credit.

e Collusion: The unauthorized collaboration with another in preparing work offered for
credit.

o Abuse of resource materials: Mutilating, destroying, concealing, or stealing such
material.

e Computer misuse: Unauthorized or illegal use of computer software or hardware
through the TCU Computer Center or through any programs, terminals, or freestanding
computers owned, leased or operated by TCU or any of its academic units for the
purpose of affecting the academic standing of a student.

e Fabrication and falsification: Unauthorized alteration or invention of any information or
citation in an academic exercise. Falsification involves altering information for use in any
academic exercise. Fabrication involves inventing or counterfeiting information for use in
any academic exercise.

e Multiple submission: The submission by the same individual of substantial portions of
the same academic work (including oral reports) for credit more than once in the same
or another class without authorization.
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e Complicity in academic misconduct: Helping another to commit an act of academic
misconduct.

o Bearing false withess: Knowingly and falsely accusing another student of academic
misconduct.

TCU Online: Our Learning Management System

Getting Started with TCU Online

Technical Requirements: Check your computer is ready by looking at the specifications list.
(https://community.brightspace.com/s/article/Brightspace-Platform-Requirements)

Log In: (using your TCU Network Credentials)
Option 1: Access via my.tcu.edu > Student Quick Links > TCU Online
Option 2: Login at http://d2l.tcu.edu

*For information about logging into TCU Online, view these instructions
(http://tcuonline.tcu.edu/kb/how-do-i-log-in/).

Student Orientation Tutorial for TCU Online: If you have not yet taken the TCU Online
Student Orientation Tutorial, please do so now. To access it, click on the Orientations semester
OR view all courses in your My Courses widget visible upon logging in to TCU Online. Click on
the "Student Orientation Tutorial” to enter the orientation course. Follow the instructions in the
course. You can return to this tutorial at any time.

How This Course Will Use TCU Online
Grades will be updated regularly on D2L.

Getting Help with TCU Online

If you experience any technical problems while using TCU Online, please do not hesitate to
contact the D2L HELP DESK. They can be reached by phone or chat 24 hours a day, 7 days a
week, 365 days a year.

Phone: 1-877-325-7778
Chat: Chat is available within TCU Online in the Help menu on the navigation bar.

If you are working with the helpdesk to resolve a technical issue, make sure to keep me updated
on the troubleshooting progress.

If you have a course-related issue (course content, assignment troubles, quiz difficulties) please
contact me.

Personal Settings & Notifications for TCU Online

As a student, you should set up your account settings, profile, and notifications. To do this you
will login to TCU Online and select your name on the top right of the screen. You can upload a
photo of yourself and add personal information to your profile. In the notifications area, you can
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add your phone number to receive text messages when grades are given, as well as reminder
texts for upcoming assignments and quizzes.

Student Success Tools for TCU Online
Pulse

Pulse is a phone app which gives you access to the course calendar, assignments, grades, and
announcements. This app provides a graph that can help you manage your time. Based on the
number of assignments and events on the course calendar for your classes, the graph will
display busy times for class work in the upcoming week. You can use this app to manage your
daily workload, and it includes the ability to view and access course materials offline. You can
download Pulse from the Google Play or Apple Store. You can learn more and download Pulse
here: https://www.d2l.com/products/pulse/.

ReadSpeaker

ReadSpeaker includes a number of tools that can enhance your understanding and
comprehension of course materials. ReadSpeaker can create an audio version of content that
you can listen to while on a page within a course or that you can download to listen offline.
ReadSpeaker can also read Microsoft Office files and PDFs. There are additional tools and
features to assist you with reading and focusing in TCU Online, tools that provide support for
writing and proofing text, and tools that can read non-TCU Online content aloud. You can learn
more about how to use ReadSpeaker tools here: https://tcuonline.tcu.edu/how-to-hub/instructor-
how-to-hub-for-tcu-online/integrations-and-mobile/readspeaker/

Support for TCU Students

Campus Offices

e Academic Advising (817-257-7486, Jarvis 104)

e Brown-Lupton Health Center (817-257-7938 or 817-257-7940)

o Center for Digital Expression (CDeX) (cdex@tcu.edu, Scharbauer 2003)
e Center for Writing (817-257-7221, Reed Hall 419)

e Counseling & Mental Health Center (817-257-7863, Jarvis Hall 2" floor)

e Dean of Students (817-257-7926, the Harrison 1600)

e Mary Couts Burnett Library: Reference Desk (817-257-7117)

e Office of Religious & Spiritual Life (817-257-7830, Jarvis Hall 1%t floor)

e Student Access & Accommodations (817-257-6567, The Harrison 1200)
e Student Success (817-257-8345, Samuelson Hall, West Entrance)

e Substance Use and Recovery Services (817-257-7100, Jarvis Hall 2" floor)
e Transfer Student Center (817-257-8345, Samuelson Hall, West Entrance)
e Veterans Services (817-257-5551, Jarvis Hall 2™ floor)
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Anti-Discrimination and Title IX Information
Statement on TCU’s Non-Discrimination Policy

TCU is committed to providing a positive learning, living, and working environment free from
unlawful discrimination, harassment, sexual misconduct, and retaliation. In support of this
commitment, in its policy on Prohibited Discrimination, harassment, sexual misconduct and
retaliation, TCU has a range of prohibited behaviors, including unlawful discrimination and
harassment and related sexual and other misconduct based on age, race, color, religion, sex,
sexual orientation, gender, gender identity, gender expression, national origin, ethnic origin,
disability, predisposing genetic information, covered veteran status, and any other basis
protected by law. The Office of Institutional Equity (OIE) is responsible for responding to
all reports of discrimination, harassment, sexual misconduct and retaliation.

Please use the following links to review TCU Policy 1.008 Prohibited Discrimination, Harassment,
Sexual Misconduct and Retaliation or to review TCU Policy 1.009 Responding to Reports of
Prohibited Discrimination, Harassment, Sexual Misconduct, and Retaliation.

To make a report, you may call OIE at 817-257-8228, email cie@tcu.edu, visit us at The
Harrison, Suite 1800 or click here: Make a Report.

To learn about the Campus Community Response Team (CCRT) and Report a Bias Incident click
here: https://inclusion.tcu.edu/campus-community-response-team/

Title IX

TCU’s Title IX Coordinator works within OIE. Andrea Vircks-McDew serves as TCU's Title IX
Coordinator. You may call 817-257-8228 to make a report, email ocie@tcu.edu or
a.vircks@tcu.edu, or make a report here. Additional Title IX resources and information are
available at https://www.tcu.edu/institutional-equity/title-ix/index.php.

Mandatory Reporters

ALL TCU employees, except confidential resources, are considered Mandatory Reporters.
Mandatory reporters are required to immediately report to OIE any conduct that raises
Discrimination, Harassment, Sexual Misconduct (Title IX or Violence Against Women (VAWA)) or
Retaliation. Mandatory reporters cannot promise to refrain from forwarding the information to
OIE.

Confidential On-Campus Resources
Campus Advocacy, Resources & Education
https://care.tcu.edu | 817-257-5225

Counseling & Mental Health Center
www.counseling.tcu.edu | 817-257-7863
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Religious & Spiritual Life
www.faith.tcu.edu | 817-257-7830

On Campus Resources
TCU Police
www.police.tcu.edu | 817-257-8400 Non-emergency | 817-257-7777 Emergency

TCU Policy for Religious Observations & Holidays

“Students who are unable to participate in a class, in any related assignment or in a university
required activity because of the religious observance of a holy day shall be provided with a
reasonable opportunity to make up the examination or assignment, without penalty, provided
that it does not create an unreasonable burden on the University.” For more information, please
visit the TCU Policy for Religious Observations & Holidays webpage.

Student Access and Accommodation

Texas Christian University affords students with disabilities reasonable accommodations in
accordance with the Americans with Disabilities Act and Section 504 of the Rehabilitation Act.
To be eligible for disability-related academic accommodations, students are required to register
with the TCU Office of Student Access and Accommodation and have their requested
accommodations evaluated. If approved for accommodations, students are required to discuss
their official TCU Notification of Accommodation with their instructors. Accommodations are not
retroactive and require advance notice to implement. The Office of Student Access and
Accommodation is located in The Harrison, Suite 1200. More information on how to apply for
accommodations can be found at https://www.tcu.edu/access-accommodation/ or by calling
Student Access and Accommodation at (817) 257-6567.

Audio Recording Notification:

Audio recordings of class lectures may be permitted by the instructor or as an approved
disability accommodation through Student Access and Accommodation. Recordings are not to
be shared with other students, posted to any online forum, or otherwise disseminated.

Emergency Response Information

View TCU’s L.E.S.S. is More public safety video to learn about Lockdown, Evacuate, and Seek
Shelter procedures. (https://publicsafety.tcu.edu/less-is-more/)

View the TCU Building Safety Maps that show the specific seek shelter locations and building
rally points for evacuation. (https://publicsafety.tcu.edu/less-safety-maps/)

View the TCU Evacuation Rally Point Map to see all rally points for evacuation.
(https://publicsafety.tcu.edu/wp-content/uploads/2020/01/TCU-Rally-Point-Map.pdf)
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Download the Frogshield Campus Safety App on your phone. (https://police.tcu.edu/frogshield/).

In the event of an emergency, call the TCU Police Department at 817-257-7777.
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Course Schedule

These are some dates and assignments that are important as we go through the semester.
These plans may need to change to enhance the class learning opportunity. Such changes
will be communicated clearly and are not unusual and should be expected.

Date Topic Preparation / Homework Class Activity

Tue. Aug. 23 Get To Know Individual/Pairs
You

Thurs. Aug. 25 Zoom Zoom Log In Submit electronic
Check signature of

received syllabus.
Tue. Sept 6 Vocals Vocal Warm-up and Voice Duet Work
Assignments
Thurs. Sept 8 Vocals Vocal Warm-up and Voice Duet Work
Assignments

Tue. Sept 13 Lyric Class discussion will take place on | Submit a copy of
Analysis vowel connection lyric markings
DUE

TBD Frog Alley Promote Mariachi Student Networking

Sat. Oct. 1 ouU Tailgate and Promote Mariachi Student
Football Performance and
Game Networking

TBD Music Preparation of Performance Student Performance
Recital pieces

Fri. Dec. 2 TCU Fine Arts | Memarize selected repertoire Perform
Gala
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** \Weekly assignments will be communicated in each class**

Student Perception of Teaching (SPOT)

Towards the end of the term you will receive an email asking you to complete your SPOT for
this course. | appreciate your thoughtful and reflective feedback to help make this course
successful for future students. You can fill out the SPOT by clicking on the link in the email or in
TCU Online when SPOTSs open.

TCU Mission Statement

To educate individuals to think and act as ethical leaders and responsible citizens in the global
community.

TCU School of Music Mission

To foster excellence in performance, teaching, creativity, and scholarship while affirming music
as an integral part of a classic liberal arts education.

TCU School of Music Vision

To become a world-class university school of music, acknowledged as one of the finest in the
country.
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Students who successfully complete this course will:
1. demonstrate professionalism, dedication, and responsibility through punctuality
at ensemble rehearsals and performances
2. demonstrate individual accountability through individual practice
3. demonstrate skills in the preparation and performance of music from varying
Mariachi styles
4. demonstrate growth and/or excellence vocally and instrumentally through individual
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Description of new course (catalog copy): include an attachment if additional space is needed

This course will introduce fundamental music techniques, music theory relevant to Mariachi, and Mexican historical
background necessary to read, understand and interpret Mariachi music in a culturally authentic manner. The course will
promote ensemble technique as well as individual growth in Mariachi performance skills. Students will reinforce their aural
and reading skills as they will engage in hands-on exercises that will develop and refine their creative and intellectual
performance ability and musical understanding of Mariachi. Students will be expected to participate in select public
performances representing TCU and the university community. This ensemble is open to all TCU students, but is designed for
students with some formal music education. All students enrolled in a mariachi course must be able to play an instrument;
therefore, vocalists will be asked to learn a mariachi-based instrument if they do not know how to play one already.

.5 credits

Course is repeatable for credit.

attached files can be seen and managed in Acrobat Pro by clicking on

Click here to attach a file
View > Show/Hide > Navigations Panes > Attachments




Fully Online Courses**

All online courses, and /or distance learning offerings must meet State Compliance regulations as defined by specific state
legislation. TCU Distance Learning is any for-credit instruction provided to a TCU student outside the State of Texas.
This includes internships, clinical, video conferencing, online, or any other delivery format that crosses state lines.
Contact the Koehler Center for Teaching Excellence for guidelines. Include a letter of support from the Koehler Center
with this proposal.

Supporting evidence or justification: (For a new course, attach proposed syllabus, including course objectives,
course outline, and representative bibliography.)

Describe the intended outcomes of the course and how they will be assessed: include an attachment if
additional space is needed

See attachment

attached files can be seen and managed in Acrobat Pro by clicking on

Sliele nsre b9 gl @il View > Show/Hide > Navigations Panes > Attachments

Additional resources required:

Faculty: No
Space: No
Equipment: No
Library: No
Financial Aid: No

Other: No

Change in teaching load: This course will be taught by adjunct instructors

Does this change affect any other units of the University? Yes || No

If yes, submit supporting statement signed by chair of affected unit.

If cross-listed, provide evidence of approval by all curriculum committees appropriate to both the originating and
the cross-listed units.



Chair of Originating Unit:

Name: Sean Atkinson

Unit: Music

Digitally signed by Sean Atkinson

signatur: Sa N AtKINSON Date: 2022.10.27 09:17:32 -05'00"
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